
 

Chapter 8.14 

Wyko NT3300 Profiling System 
​ (wyko)​ (Nanolab 380) 
1.0​ Equipment Purpose 

1.1​ Wyko NT3300 white-light interferometer system is designed to profile objects (structures) by using 
interferometry instead of a stylus. The profiles of released MEMS structures can be measured 
without contacting the device, which can greatly minimize the chance of destroying the fragile 
structure/s. More details about this non-contact profiling and its capability are available in section 
8.0 of this manual chapter. The wyko system is shown in Figure 1. 

1.2​ This document has specific information about the capabilities, configuration, and proper operation 
of the NT3300 white-light-interferometer profiling system. The analysis software and automation 
features for the wyko are quite extensive, and are therefore not covered in this manual. See the 
online help or the wyko reference manual for more details. The machine is easy to learn to use, 
but takes time to master. Interferometry is sometimes an art, if you are new to interferometry (or 
even if you are quite experienced), you should always question the validity of the measurement. 
The thin films we measure are often transparent at the wavelength we measure with (centered 
around 600 nm), and therefore multiple reflections from the substrate can give bogus 
measurements. 

2.0​ Material Controls & Compatibility 

2.1​ This system can accommodate samples in excess of 8-inches. Powders, flaking materials, and 
wet samples are not permitted. 

3.0​ Training and Applicable Documents  

3.1​ Basic Tool 
3.1.1​ This tool requires enabling and a formal qualification session, but does not have an 

online test. 
3.1.2​ Timeline: 

3.1.2.1​ Get trained by any qualified member. 
3.1.2.2​ Arrange a qualification session with a superuser to show competency on the 

tool. 
3.1.3​ Estimated time to completion: 1-2 days. 

3.2​ Wyko NT3300 Reference Manual 

3.3​ Recommended Reference Videos (not UC Berkeley): 

3.3.1​ Veeco Wyko Non-contact Profilometer NT3300 (1 of 2) - training video (Georgia Tech - 
Microelectronics Research Center) 

3.3.2​ Veeco Wyko Non-contract Profilometer NT3300 (2 of 2) - training video (Georgia Tech - 
Microelectronics Research Center) 

4.0​ Definitions & Process Terminology 

4.1​ PSI: Phase-Shift Interferometry 

4.2​ VSI: Vertical-Scanning Interferometry 

4.3​ FOV: Field-Of-View object, and set of lenses that increase the microscope power from 0.5 - 2X. 

 

https://www.youtube.com/watch?v=prUANnlQFFQ&t=314s
https://www.youtube.com/watch?v=prUANnlQFFQ&t=314s
https://www.youtube.com/watch?v=kzfn9C5Y6cs
https://www.youtube.com/watch?v=kzfn9C5Y6cs


 

4.4​ The wyko operator station is shown in Figure 2. The joystick controls the motorized stage (and 
microscope head for tip/tilt) and the rotating control knob controls the microscope head height 
(focus). 

5.0​ Safety 

5.1​ The wyko is a relatively safe machine to use. Care should be taken not to get fingers caught in the 
motorized stages. There is an emergency-off button in case of smoke, sparks, fire, etc. 

5.2​ Never lower the z-axis without looking at the objectives to make sure they do not crash into your 
sample. 

5.3​ Never install software on the system. 

6.0​ Process Data 

6.1​ This tool has not been characterized by staff 

7.0​ Available Processes, Gases, Process Notes 

7.1​ Measurement Technique 

7.1.1​ The Wyko NT3300 interferometer determines the profile of an object using interferometry 
instead of a stylus. Therefore, the profiles of released MEMS structures can be measured 
without destroying them. The wyko has a range of objectives from 2X-50X and has an 
additional zoom from 0.5-2X called the field-of-view (FOV) objective. There are two 
measurement techniques: 1) phase-shift interferometry (PSI) that uses a single 
wavelength of light, and 2) vertical-scanning interferometry (VSI) that uses multiple 
wavelengths of light. The PSI mode is used to measure continuous surfaces (surfaces 
with step-heights less than lambda/4, or about 150 nm) that are within the depth-of-field 
of the objective you are using, and is accurate to about 1 nm (with work, it can be as 
good as ~0.1 nm). The VSI mode is good for measuring step heights as high as 5 mm 
(yes, millimeters!), but has a reduced accuracy of about 10-30 nm. It measures tall 
features by scanning the microscope head downwards and measuring the response of 
the light intensity of each pixel. Use the VSI mode for continuous structures that extend 
beyond the depth-of-field of the objective you are using (i.e. for cantilevers with large 
strain gradients). 

7.2​ Resolution 

7.2.1​ The wyko takes nm-resolution static measurements in the z-axis (along the optical path) 
and µm-resolution measurements in the x and y axes. Resolution in the x- and y-axes is 
limited by optical diffraction and varies depending on which lens is used. Best case, it 
cannot be better than the wavelength of light, lambda, used to take the measurement 
(lambda~=600 nm). Because transverse (perpendicular to the optical axis) resolution is 
limited by diffraction, the wyko is NOT a good tool to determine surface roughness 
smaller than lambda. An AFM is better suited for this type of measurement. 

7.3​ Measurement Limitations 

7.3.1​ Measurements should be made on one type of material. When more than one material is 
encountered, the step height between materials is not accurate because the phase 
returned from the materials is not the same. In the PSI mode, errors of up to ~300 nm 
(lambda/2) are possible. In VSI mode, it is quite possible that errors are as large as a few 
microns. When you have more than one material (i.e. measuring photoresist step heights 
or a deep-trench etch that still has a PR mask) you should verify the measurement with 
some other means to build confidence that what you are getting is correct. If you need 
very accurate measurements, consider coating the wafer/die with a thin film of gold or 
some other reflective material if you can. 

 



 

7.3.2​ As alluded to in the opening section, measuring thin films can give unreliable results at 
times. The wyko has decent software to determine the upper surface of a structure, but 
the software has been known to fail. Always question the validity of the measurement 
results. It is usually quite obvious when a measurement is bad if you use your a priori 
knowledge of what you are measuring (i.e. a radius-of-curvature of 10 microns is most 
likely not accurate). 

8.0​ Equipment Operation 

8.1​ Start Up 

8.1.1​ The wyko may be powered down unless a user was taking measurements just prior to 
you. Press the green start button to power up the interferometer and computer. If the 
power does not come on, turn the red emergency-off button clockwise (or pull it out), and 
then press the power button again. Turn on the computer monitor. 

8.1.2​ Log on to the computer once it has booted up. 

8.1.3​ Enable WYKO. 

8.1.4​ Start the measurement software from Start->Programs->wyko->Vision32 or double-click 
the Vision32 icon on the desktop. 

8.1.5​ Let the interferometer warm up (5-10 minutes should be enough) before continuing. 

8.2​ Stage Motion 

8.2.1​ The computer-controlled stage is controlled with the x/y axis controller shown in Figure 2. 
Moving the joystick controller will move the stage when the wyko software is running. 
Pressing the high-speed button and moving the joystick simultaneously will move the 
stage faster. 

8.3​ Focusing 

8.3.1​ Focus is adjusted by rotating the z-axis controller. Pressing the high-speed button and 
rotating the z-axis controller simultaneously will change the focus much faster. You 
should always raise the objectives while looking at the sample monitor when focusing the 
wyko. This will prevent you from crashing them into your sample. To focus, first lower the 
objective while watching the object to a distance slightly less than the working distance of 
the objective (50X: 2.5 mm, 20X: 3.5 mm, 10X: 6 mm). Then raise the objective slowly 
while watching the monitor. You can get a quick estimate if you are close to focus by 
looking at the spot the wyko (or any other microscope for that matter) projects onto the 
sample. The microscope is in focus when the spot size is at a minimum (and the spot has 
well-defined edges). 

8.4​ Tilting the Microscope Head 

8.4.1​ The microscope head can be tilted in two axes (tip/tilt) to level the sample with respect to 
the microscope. Tilt with respect to the microscope objective results in many interference 
fringes across the sample. (It is easier to rotate the microscope head than to tilt the 
stage.) To adjust tip/tilt, press the tip/tilt button while moving the joystick. Tilt adjustments 
are best done after the sample is in focus and interference fringes are apparent. It is 
easiest to adjust one axis at a time. At first, tilt adjustments can be confusing. Practice 
will make you an expert in a short amount of time! 

8.5​ Calibration 

8.5.1​ The wyko must be calibrated every time it is powered up (or once a month for VSI and 
daily for PSI, if the machine is on for extended periods). There are two calibrations, one 
for PSI mode, and one for VSI mode. You only have to calibrate for the mode you will use 

 



 

to measure. The following directions explain the calibration procedure. You must 
demonstrate calibration to the superuser to qualify. 

8.5.2​ Place the appropriate calibration standard under the microscope objective and focus on 
the surface. Best focus is when the fringes have maximum contrast. For calibration 
purposes, it does not matter which objective you use. Lower-power objectives (i.e. 10X) 
are often easier to work with because of the larger field-of-view and depth-of-focus. 
Figure 3 shows the two types of calibration standards. These standards are very 
expensive, a few thousand dollars, and should only be cleaned by staff. Do not touch the 
surfaces of the standards. The VSI standard has already been broken due to misuse. 
Fortunately the step structure is still intact so it can still be used. Please be careful when 
focusing the microscope. 

8.5.3​ Open the Measurement Options (Hardware->Measurement Options…) 

8.5.4​ Select the desired (camera) resolution from the Options page. 

8.5.5​ Select the type of measurement you will be using: VSI or PSI. (It is often easier to see 
fringes in the PSI mode because the coherence length is longer. Once you have focused 
well enough to see fringes, you can switch to the VSI mode). 

8.5.6​ Choose an objective. Which one does not matter, but a large field of view is often helpful 
(e.g. use the 10X objective). 

8.5.7​ Choose an FOV. Which one does not matter, but a large field of view is often helpful (e.g. 
use the 1X FOV).  

8.5.8​ Adjust the intensity (press the Intensity button on the bottom of the 
Hardware->Measurement Options page) so that the camera is not saturated (denoted by 
red regions on the intensity window). It is necessary to adjust the intensity before 
calibrating because of a bug in the software. The calibration routine lets you adjust 
intensity, but it resorts to the intensity before the calibration routine. 

8.5.9​ Use the default settings for everything else 

8.5.10​ Press the Calibrate button. 

8.5.11​ Check the Auto Calibrate check box (i.e. do not Verify the calibration - another bug). 

8.5.12​ Do not check All Modes (again, a bug in the software does not keep the intensity value 
you set during the calibration). 

8.5.13​ Be sure to check the View Initial Calibration Value checkbox. Then, make sure the 
number, when displayed, is approximately 0.9 on 1X speed, and 2.7 (about 3 times 
larger) on 3X speed for the VSI mode, and 34.2 for the PSI mode. This is necessary to let 
the calibration converge. If the calibration fails, it is often necessary to reset this initial 
calibration value. 

8.5.14​ Click Next, and follow the directions in the dialog box. 

8.5.15​ When doing a VSI calibration, start off in PSI mode. The coherence length is much 
longer, which means there is a greater distance over which the interference fringes 
appear. Begin by focusing on the sticker. The sticker has a lot of contrast, so it is easy to 
focus on. Then move the stage so you are looking at the metal/glass transition. The spot 
projected by the wyko should be half on the glass and half on the metal. It is easiest to 
see it from the side by eye. The glass is thick and transparent. There is a possibility you 
are now focused on the bottom surface of the glass. The bottom surface is the wrong 
surface, so raise the objective until the edge of the glass is in focus. When you are in 
focus, fringes should appear. If they do not appear, move the objective up and down a 
little (one or two turns without pressing the fast button) to get in into best focus. If fringes 
still do not appear, make sure you are in PSI mode. Once fringes appear, move the stage 

 



 

so the objective is over the calibration step. The step will most likely be out of focus now, 
but you have an edge to focus on. Refocus until you see fringes. Once you have fringes, 
switch to VSI mode. If you lose the fringes, you weren't at best focus, so readjust the 
focus until they reappear. 

8.6​ Operation 

8.6.1​ Choose the proper objective to image your sample with. Rotate the turret using the 
knurled (rough) ring. NEVER TURN THE TURRET ON ANY MICROSCOPE USING THE 
LENSES. Doing so can misalign the objectives. DO NOT REMOVE THE OBJECTIVES 
FROM THE TURRET. THEY HAVE BEEN ADJUSTED SO THEY ARE PARFOCAL WITH 
EACH OTHER. 

8.6.2​ Place the sample under the microscope objective making sure that the objective will not 
hit the sample. It is useful to flatten the sample by adjusting the tip and tilt of the 
interferometer so there are few to no fringes seen on the sample. (The remaining tilt can 
be removed during post processing.) 

8.6.3​ Select the measurement mode, VSI or PSI, from Hardware->Measurement 
Options->Options.  

8.6.4​ For PSI mode, focus on the structure until you have the best fringe contrast. 

8.6.5​ For VSI mode, focus for best fringe contrast on the uppermost part of the structure. 

8.6.6​ Select the proper scan lengths, Backscan and Length, from Hardware-​
>Measurement Options->VSI Options. 

8.6.7​ The scan length Length is the distance the microscope will scan going down from its 
present position. 

8.6.8​ The scan length Backscan is the distance the microscope will scan above the present 
position before it scans below the present position. 

8.6.9​ Adjust the intensity, Hardware->Measurement Options->Intensity, to maximum intensity 
without saturating the camera (as seen by regions of red on the intensity screen). 

8.6.10​ Take the measurement File->New Measurement. You can save your measurement on the 
local drive E:<login name>. Do not leave large amounts of data here. Assume that the 
data is not safe for more than a day. Transfer the data to the ZIP drive (F:) or copy them 
on the CDRW drive that are located in the computer cabinet under the wyko optical head. 
Transferring file via Zip 100 drive can be done by the following steps:  

8.6.10.1​ Copy files to the Zip 100 drive on the wyko (My Computer -> Removable Disk 
(F:)) 

8.6.10.2​ Take the Zip drive over to the  lab terminal 3-7 a short distance from the wyko. 

8.6.10.3​ Use the external Zip 100 drive on  the lab terminal 3-7 and Explorer to transfer 
files to a USB Flash drive (or use a network file transfer program). 

8.6.10.4​ Return the Zip 100 drive to the wyko machine so that other members can find 
it. 

8.6.10.5​ Zip 100 drives can be checked out from the storeroom. Do not use Zip 250MB 
drives on the wyko. 

8.7​ Analysis 

8.7.1​ Post-processing routines that come with the wyko software are extensive and cannot be 
adequately explained here. For a better understanding of what is included, experiment 
with the software and consult the online documentation or the reference manual. 

 



 

8.7.2​ The Vision32 analysis software can be installed on your local machine. Disks with the 
programs are available for loan from the NanoLab office. When installing the software, 
select NT2000 for the instrument type and select workstation mode. 

8.8​ Shutdown 

8.8.1​ Disable wyko on Mercury. 

Troubleshooting Guidelines 

8.9​ The calibration keeps failing. What should I do? 

8.9.1​ If calibration fails, make sure you have checked Auto Calibrate.  If the light intensity is 
oversaturating the detector, as seen by red areas in the imaging field, reduce intensity 
and try calibration again. For VSI calibration, make sure the Initial Calibration Value is 
between 0.9 and 1.0. You can change this value by choosing the View Initial Calibration 
Value option during the VSI calibration.  Setting this to 0.9 is a good starting value.  
Lastly, it's also important to note that the scan of the focal plane is from high to low on the 
VSI step. The system will only calibrate if the initial focus and setting of fringes is on the 
highest part of the step, 

8.10​ 20X Lens Known Issue 

8.10.1​ There is a known issue with the 20X lens, in that the interference fringes do not appear 
when the sample itself is in focus. We do not recommend using the 20X lens at this time. 

8.11​ Plate for thin samples 

8.11.1​ There is a black plate that is used when imaging thin samples (including 6” wafers). The 
objective motors do not have enough vertical travel to measure a 6” sample placed 
direction on the silver stage. 

9.0​ Figures & Schematics 

 

Figure 1 - Wyko NT3300 Profiling System 

 



 

 

 

Figure 2 
a) PSI-mode calibration standard​ b) VSI-mode calibration standard 

10.0​ Appendices 

10.1​ Miscellaneous Precautions, Guidelines & General Rules 

10.1.1​ Do not lean on the optical stage or the machine in general. 

10.1.2​ Do not turn the knobs on the mechanical stage when it is powered up. 

10.1.3​ Rotate the turret using the knurled (rough) ring. NEVER TURN THE TURRET ON ANY 
MICROSCOPE USING THE LENSES. Doing so can misalign the objectives. This is good 
practice for all microscopes, since rotating the turret using the objectives can damage 
them over time.  

10.1.4​ DO NOT REMOVE THE OBJECTIVES FROM THE TURRET. THEY HAVE BEEN 
ADJUSTED SO THEY ARE PARFOCAL WITH EACH OTHER. 

10.1.5​ Use PSI mode for continuous surfaces that are in the depth of focus. 

10.1.6​ Use VSI mode for stepped structures or any other structure that is not completely in the 
depth of focus. 

10.1.7​ Make sure not to crash the objectives into the structure when focusing or when using the 
VSI mode. NEVER focus downward, only upward. 

10.1.8​ Do a calibration every time the machine has been powered up or on a daily basis for PSI 
and on a monthly basis for VSI mode. 

10.1.9​ The objectives should be parfocal (they focus at the same height), so when focusing on 
an object, you can use the low-magnification objective to find the focus. This is easier 
since you will see more structures and the depth of focus is larger for the 
low-magnification objective. Then rotate the turret to the lens you need. 

10.1.10​If your structures are highly curved, use the highest-power objective possible. You can 
use the 0.5 FOV to view a larger field if need be. The higher-magnification objectives 
have a larger numerical aperture, and can therefore collect a larger angle of incoming 
light. 

 



 

10.1.11​Never use any kind of sticky stuff (tape, clay, etc.) to mount your structures or fasten 
wires. There is an optical-bench breadboard that can be used to affix wires by using 
clamps screwed in with 1/4-20 screws. 

10.1.12​Store your files in the E:<login name> directory. Please remove files when you are done. 
If drive space gets full, files will be deleted randomly to make space. 

10.1.13​Never install software on the system, it might conflict with the wyko software or 
compromise the operating system. 

10.1.14​Optical measurements in general are not good for surface roughness since the lateral 
resolution of the interferometer is not good enough. You should use an AFM for 
surface-roughness measurements. 

10.1.15​Never turn the knobs on the stage manually with the power on. 

10.1.16​To do a screen capture, press Crtl-PrtScn. The screen capture is stored on the clipboard. 
You can now paste it into another program, or open the clipboard and save it as a 
clipboard file. 

10.1.17​Use the default configuration if you are having troubles with the software. Store your own 
configurations in your own directory E:<login name>. The default configuration is in 
c:\...\wyko.ini 

10.2​ Zip Disk File Transfer: 

10.2.1​ 1 Grab the wyko Zip100 disk (hopefully on the table). Insert into the system unit (open 
cabinet). 

10.2.2​ 2 Copy files to the Zip 100 drive on the wyko (My Computer -> Removable Disk (F:))  

10.2.3​ 3 Transfer by walking drive to lab3-7. Use the external Zip 100 drive. 

10.2.4​ 4 Use Explorer to transfer files to a USB Flash drive (or use a network file transfer 
program). 

10.2.5​ 5 Return the Zip 100 drive to the wyko table so other members can find it. 

10.2.6​ Additional Zip 100 drives can be checked out from the storeroom. 

10.3​ Flash Drive File Transfer: 

10.3.1​ 1 Plug flash drive into Sheeva Plug USB port (a white box near the monitor). 

10.3.2​ 2 Wait 10 seconds. 

10.3.3​ 3 Access files on the wyko desktop via the desktop shortcut "USB FlashDrive"  

10.3.4​ (or from the Z: drive). Note: Executable files on the flash drive will not be available on the 
wyko. 
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